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The volume, location and extent of historical lava flows are important when
assessing volcanic hazards, as well as the productivity or longevity of a volcanic
system. We use a Landsat/Hyperion/ALI dataset and automated classification
methods to map lava flows at Nyamuragira volcano (1967-2011) in the Democratic
Republic of the Congo. The humid tropical climate of Nyamuragira is advantageous
because its lava flows are emplaced onto heavily forested flanks, resulting in strong
contrast between lava and vegetation, which contributes to efficient flow mapping.
With increasing age, there is an increase in Landsat band-4 reflectance, suggesting
lava flow revegetation with time. This results in a distinct spectral contrast to
delineate overlapping flows emplaced ~ 5 years apart. Areal extents of the flows are
combined with published lava flow thicknesses to derive volumes. The Landsat/
Hyperion/ALI dataset is advantageous for mapping future flows quickly and
inexpensively, particularly for volcano observatories where resources are limited.

1. Introduction
1.1. Lava flow mapping

Mapping lava flows from volcanic eruptions serves many purposes, such as the
determination of vent locations, the areal extents of flows (widths and lengths), and
flow volumes. Knowledge of the geographical position and direction of flows is used in
hazard prediction (Trusdell 1995). Lava volumes can be estimated through either a
combination of lava flow area with field-based lava flow thickness measurements (Shaw
and Swanson 1970; Self ez al. 1997; Crown and Baloga 1999) or subtraction of pre- and
post-eruptive digital elevation models (DEMs) (Rowland et al. 2003; Lu et al. 2004).
These volumes can be used in magma supply models and time-series analyses of
volcanic activity to further the understanding of eruption mechanisms (Burt e al.
1994). At volcanoes situated in remote or politically unstable locations where ground-
based monitoring and fieldwork are hazardous or impossible, airborne and spaceborne
remote sensing techniques are particularly useful (Abrams et al. 1991; Harris et al.
1999; Carn and Oppenheimer 2000; Carn er al. 2003; Patrick et al. 2003). For
Nyamuragira volcano in the Democratic Republic of the Congo (D.R. Congo), this is

*Corresponding author. Email: emhead @mtu.edu

Geomatics, Natural Hazards and Risk
ISSN 1947-5705 Print/ISSN 1947-5713 Online © 2012 Taylor & Francis
http://www.tandf.co.uk/journals
http://dx.doi.org/10.1080/19475705.2012.680503



Downloaded by [SUNY Brockport] at 08:32 07 December 2012

2 E.M. Head et al.

certainly the case. Not only is Nyamuragira’s lava flow field remote, it is also extensive
(figure 1), and persistent insecurity in the region continues to preclude detailed field
surveys of the entire flow field. Therefore, remote sensing has proven to be a crucial
tool to investigate Nyamuragira’s eruptive behaviour (Carn and Bluth 2003; Colclough
2005; Bluth and Carn 2008; Smets et al. 2010).
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Figure 1. The inset map, an ASTER GDEM, shows the location of Nyamuragira (D.R. Congo)
within the western branch of the East African Rift near the Rwandan border. Inactive Virunga
volcanoes are shown: K-Karisimbi; Mi-Mikeno; S-Sabinyo; V-Visoke; Mu-Muhavara. The larger
Landsat image, acquired 21 February 2005 (band 4), reveals Nyamuragira’s prolific lava flows
including outlines of the 2006, 2010 and 2011 flows we mapped using automated classification.
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1.2. Volcanic activity at Nyamuragira

The western branch of the East African Rift can be divided into four volcanic
provinces from north to south: (1) Toro-Ankole in western Uganda, (2) Virunga and
(3) Kivu spanning the D.R. Congo, Rwanda, Burundi, and southern Uganda and (4)
the Rungwe in southern Tanzania (Kampunzu et al. 1998; Ebinger and Furman
2002). Nyamuragira (also known as Nyamulagira; 1.41°S, 29.20°E) and its
neighbouring volcano, Nyiragongo, are part of the Virunga volcanic chain and are
the only active volcanoes in the western branch (figure 1). The currently inactive
Virunga volcanoes are Muhavara, Sabinyo, Visoke, Mikeno and Karisimbi.

Nyamuragira erupted 16 times between 1980 and 2011, making it one of the
world’s most active and productive volcanoes (Smithsonian, Institution, monthly
reports, 1971-2011, http://www.volcano.si.edu/world/volcano.cfm?vnum=0203-
02=&vol page=var, hereinafter referred to as Smithsonian Institution, monthly
reports, 1971-2011 (e.g. Smithsonian Institution 1971-2011)). A shield volcano with
a near-circular summit caldera measuring 2 x2.3 km at an elevation of ~3 km,
Nyamuragira produces low-silica, high alkali lava compositions (SiO, ranging from
43 to 56 wt.%; NaO + K,O up to 7 wt.%), which have reached flow rates of up to
~20 km/h (Aoki et al. 1985; Hayashi et al. 1992; Smithsonian Institution 1971-
2011). Based on reports from the Smithsonian’s Global Volcanism Network (GVN;
Smithsonian Institution 1971-2011), most of Nyamuragira’s eruptive history has
consisted of summit (intra-caldera) and effusive flank eruptions. Nyamuragira
eruptions typically begin with ~200 m high fire fountains and contemporaneous
lava flows. Tephra fall is commonly reported during Nyamuragira eruptions, and
ash from several eruptions has been associated with destruction of crops and health
problems in the surrounding area (Smithsonian Institution 1971-2011).

1.3. History of Nyamuragira lava flow mapping

Thonnard et al. (1965) produced a map showing Nyamuragira lava flows erupted
until 1958. Kasahara et al. (1991) compiled published volumes from several
sources for individual eruptions between 1900 and 1991, although no lava flow
map was created. Since 1994, political unrest in the D.R. Congo has prohibited
not only ground-based mapping efforts, but also most ground-based volcano
monitoring of Nyamuragira (e.g. volcanic gas measurements, levelling surveys)
from the Goma Volcano Observatory. Therefore, satellite observations have been
essential for post-1994 studies of volcanic activity in the Virunga. Satellite-based
radar mapping efforts were carried out for individual flows and cones from
Nyamuragira (Mackay and Mouginis-Mark 1997; Colclough 2005), Nyiragongo
(Mackay and Mouginis-Mark 1997; Colclough 2005), and Karisimbi (Mackay
and Mouginis-Mark 1997). A more recent study by Smets et al. (2010) utilized
radar data and optical imagery, and the Thonnard et al. (1965) map, to manually
trace lava flow boundaries and map Nyamuragira lava flows erupted between
1938 and 2010. Herein, we apply automated classification methods to Landsat
data, with the addition of Hyperion and ALI data when cloud-free Landsat
scenes were unavailable, to map lava flows erupted from Nyamuragira between
1967 and 2011. We describe the image processing techniques used to delineate the
lava flows, and compare our results with prior Nyamuragira mapping efforts
(Colclough 2005; Smets et al. 2010).
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As cloud cover can hinder satellite-based lava flow mapping using optical datasets,
it is best to utilize satellite data from a variety of sources, collected on a range of
days. Combining high spatial resolution aerial photography with medium-to-high
spatial resolution optical, thermal (temperature) and radar (textural) satellite data
would be optimal, as it would allow a more complete characterization of the lava
flows, although high spatial resolution data can be prohibitively expensive for
resource-limited volcano observatories. For our mapping efforts, we assessed the use
of aerial photographs, which have been used in the past to aid lava flow mapping
(Ray 1960; Abrams et al. 1996; Legeley-Pandovani et al. 1997). However, historical
photography has been poorly preserved for Nyamuragira. Aerial photography of the
Nyamuragira lava flow field with little or no metadata only exists up to the 1950s (B.
Smets pers. comm.), while new orthographic aerial photography is difficult to obtain
due to the current political climate. In contrast, remotely sensed satellite imagery is
readily available.

Since radar can penetrate cloud cover, it is a useful tool in tropical regions such as
Nyamuragira where cloud cover is significant (e.g. Carn 1999). Satellite-based radar
imagery has been used to map Nyamuragira’s lava flows (Colclough 2005; Smets
et al. 2010), although Colclough (2005), who attempted mapping of the 1998 and
2001 Nyamuragira flows, points out that radar prohibited the mapping of all
downslope flow sections. Colclough (2005) used 11 ERS 1/ERS 2 synthetic aperture
radar (SAR) images acquired between 1997 and 2003, and compared the
backscattered energy between SAR pairs to assess changes over time, such as the
emplacement of new lava flows. The 1998 and 2001 flows were emplaced on top of
older flows downslope, all of which produced a similar backscattering signal in the
5.66 cm (C-band) wavelength, preventing the separation (delineation of boundaries)
between the fresh and older flows. Colclough (2005) used optical satellite data to
supplement and/or verify the ambiguous flow boundaries resulting from the radar
imagery. Smets et al. (2010) used individual SAR images and SAR pairs from ERS 1/
ERS 2 (C-band), ENVISAT (C-band) and JERS (L-band: 23.5 cm) satellites for the
purpose of delineating overlapping lava flows near the summit through textural
differences between flows. However, they make it clear that a combination of radar
and optical imagery was necessary. In this study, we focus on an optical satellite
dataset, since these data are more readily available than radar for routine mapping
efforts.

Optical satellite data are often free and have been used to map lava flows
utilizing various approaches (Abrams et al. 1991, 1996; Kahle et al. 1995; Lu
et al. 2004), including on-screen digitising (tracing) of lava flow boundaries and
automated classification using supervised and unsupervised algorithms. Auto-
mated classification, performed via image processing software, evaluates every
pixel in a scene and then groups the pixels with similar values (e.g. digital
number, reflectance, radiance) into a specified number of classes. Image
processing software can be costly, although freeware exists (e.g. MultiSpec:
https://engineering.purdue.edu/ ~ biehl/MultiSpec/; GRASS GIS: http://grass.-
fbk.eu/), which would allow a volcano observatory with limited funds to carry
out unsupervised classification and digitization on optical satellite data. Here, we
use automated classification methods with Landsat multi-spectral scanner (MSS),
thematic mapper (TM) and enhanced thematic mapper (ETM+), and Earth
Observing-1 (EO-1) Hyperion and Advanced Land Imager (ALI) imagery to
delineate lava flows from Nyamuragira volcano.
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One of the advantages of Nyamuragira’s humid tropical location is that its lava
flows are usually emplaced onto heavily forested flanks, resulting in strong contrast
between lava and vegetation, typically allowing rapid and automated mapping.
Visible to short-wave infrared (VSWIR) satellite imagery, therefore, proved optimal
for mapping the Nyamuragira lava flow field. This was our main motivation for
choosing the Landsat-Hyperion-ALI dataset. These data have a low cost (most data
are now free) and the Landsat data in particular provide a longer-term archive
(beginning in 1972) relative to other VSWIR sensors such as the advanced
spaceborne thermal emission and reflection radiometer (ASTER), the Indian remote
sensing satellites and Systéme Pour I’Observation de la Terre (SPOT). An additional
advantage is that the free dataset and processing software would allow researchers or
observatories in developing countries with limited resources to efficiently update the
map when new lava flows occur. Due to the lack of a cloud-free Landsat scene for
mapping the 2010 and 2011 flows, we used Hyperion and ALI images, respectively.
We show that our area and volume estimates agree well with the estimates of Smets
et al. (2010), which suggests that the methods we used with free satellite imagery are
promising and cost-effective for Nyamuragira, as well as for similar lava flows on
other volcanoes.

2. Data acquisition and mapping methodologies
2.1. Data preparation

The specifications and characteristics of the Landsat MSS, TM and ETM+,
Hyperion, and ALI scenes obtained for mapping are given in tables 1 and 2,
respectively. For consistency, our original intent was to use only Landsat data, but
the clearest Landsat image of the 2010 flow available to date (18 January 2010) was
acquired while the volcano was still erupting. An eruption cloud obstructed part of
the flow and the northern-most vent was issuing hot lava, which saturated the SWIR
bands. The application of automated processing techniques was not possible due to
these effects. In place of Landsat, we used a Hyperion scene acquired on 28 May
2010 to complete the 2010 mapping. For the 2011 flow, we had similar problems. The
eruption began on 6 November 2011 and it is still continuing at the time of writing.
Current activity includes lava flows and occasional Strombolian eruptions, although
at a lower level of intensity than previously observed. A cloud-free Landsat scene
(acquired on 9 February 2012) does exist, but it captured the erupting lava flows,
which saturated the SWIR bands and prevented automated processing. In place of
this Landsat scene, we used an ALI image acquired on 3 January 2012. Since
Nyamuragira was degassing during the ALI acquisition, eruption clouds did
obstruct a small southern portion of the flow in this image. However, we were able to
use the Landsat scene from 9 February to make minor modifications to the flow once
the automated classification was performed on the ALI image.

The Hyperion image was acquired ~ 3 months after the 2010 flow emplacement,
and the ALI image was acquired ~1 month after the 2011 eruption began, which
preserved a good contrast between the fresh 2010/2011 lava flows and the
surrounding older lava flows and vegetation. For the Landsat dataset, images
acquired closest to the date of flow emplacement were used to map that particular
flow. This ensured the largest contrast between fresh lava flow and surrounding
vegetation and/or older, weathered lava flows. For example, the 1986 Landsat image
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Table 2. Landsat, Hyperion, and ALI scenes used to map Nyamuragira lava flows. GloVisis a
USGS web site from which optical satellite imagery can be downloaded (http://
glovis.usgs.gov/).

Scene Date of acquisition Image ID (Path: 173, Row: 61) Source
Landsat MSS 2 12 March 1975 LM21860611975071AAA03 GloVis
Landsat TM 4 December 1984 LMS51730611984339AAA03 GloVis
19 July 1986 LT51730611986200XXX01 GloVis
7 August 1987 LT51730611987219XXX05 GloVis
4 August 1989 LT41730611989216XXX06 GloVis
17 January 1995 LT51730611995001AAA01 GloVis
2 February 1995 LT5173061009503310 GloVis
Landsat ETM+ 6 December 1999 LE71730611999340SGS00 GloVis
15 June 2000 LE71730612000167EDC00 GloVis
3 September 2000 LE71730612000247EDC00 GloVis
11 December 2001 LE71730612001345SGS00 GloVis
31 January 2003 LE71730612003207EDCO01 GloVis
21 February 2005 LE71730612005052ASN00 GloVis
15 January 2009 LE71730612009015ASNO00 GloVis
28 September 2009 LE71730612009271 ASNO0O GloVis
18 January 2010 LE71730612010018ASNO0 GloVis
Hyperion 28 May 2010 EO1H1730612010148110KF GloVis
ALI 3 January 2012 EO1A1730612012003110PF GloVis

captured the 1986 Nyamuragira flow as it was being emplaced, saturating the SWIR
bands, and preventing the application of automated classification methods. The next
best (cloud-free) Landsat image was acquired in 1987 and provided a clear image on
which to apply the automated techniques, resulting in a robust classification. By
choosing Landsat scenes as close to the eruption date as possible, we also increased
the possibility of mapping lava flows prior to the emplacement of subsequent,
overlapping flows.

All of the scenes were reprojected to the 15 June 2000 image using a UTM zone 35
south projection and the WGS 84 datum. Only bands 1-5 and 7 from the Landsat
TM and ETM+ scenes were used, whereas bands 41-76 with 0.76-0.90 um
wavelengths from the hyperspectral Hyperion scene were used. These Hyperion
wavelengths correspond to a single Landsat band (band 4), providing much higher
spectral resolution than the single Landsat band. This band (4) was found to be most
responsive to lava flow weathering and vegetation with age (Abrams ef al. 1991).
ALI and Landsat VSWIR bands cover a similar spectral range, although ALI data
include three additional bands, providing a better spectral resolution than Landsat
(table 1). All nine ALI VSWIR bands (1-7), therefore, were used to map the 2011
flow. The thermal infrared (TIR) band did not prove to be crucial for our mapping;
thus, excluding this band from the Landsat datasets provided a fixed spatial
resolution for all bands. The Landsat MSS scene was resampled to 30 m in order to
allow a direct comparison with the TM/ETM+ imagery.

2.2. Principal components analysis (PCA)

Principal components analysis (PCA) on both TIR and VSWIR satellite data has
been successfully used to map lava flows and volcanic tephra units for individual and
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multiple flows (e.g. Abrams et al. 1991, 1996; Legeley-Padovani et al. 1997; Wiart
et al. 2000). A PCA was performed on the Landsat and ALI datasets, but not on the
Hyperion image as the latter included only 0.76-0.90 um wavelengths. The Landsat
and ALI images were subset around the lava flow field to permit a faster analysis
because fewer pixels were input into the PCA.

For each multi-spectral satellite image, several bands may contain similar
information. The purpose of a PCA is to reduce this redundancy by comparing
the spectral information in each band with that in every other band via an
orthogonal transformation, so that the first principal component (PC) represents the
greatest variance of the data, the second PC represents the second greatest variance
of the data, and so on. The number of PCs generated is equivalent to the number of
input bands; for example, six PCs were generated for the Landsat TM and ETM +
data. Since the PCA technique compresses the useful spectral information into fewer,
uncorrelated components, the scene can be represented by ~3 components rather
than six bands and overall noise is reduced.

2.3. PCA evaluation

Prior to attempting a classification of the flows, three PCs were chosen that best
highlighted the flow of interest (figure 2). For roughly half of the lava flows, the first
three PCs provided the best contrast between the lava flow and the surroundings and
were, therefore, combined for subsequent unsupervised classification. We only
deviated from using PCs 1-3 when other PCs more clearly highlighted the flow of
interest (e.g. 1981, 1984 and 2001, as well as parts of the 1996 and 2000 flows). To
investigate why deviations from PCs 1-3 were necessary, we examined our factor
loading calculations (Appendix A) for each of the Landsat scenes we used. The
factor loadings are coefficients of the PCA transformation and determine which
bands of the original imagery contributed most to each PC.

Regardless of whether we used PCs 1-3 or deviated from this combination, the
most dominate contributions to the PCs used were from bands 1, 2, 3 and, less
extensively, band 4 of the original data. This appears to correlate with the large
amount of vegetation in each Landsat scene. Band 1 is responsive to waterbodies and
blue chlorophyll absorption in vegetation, band 2 is responsive to blue and red
chlorophyll absorption and green reflectance of healthy vegetation, band 3 is
responsive to red chlorophyll absorption of healthy vegetation, and band 4 is
sensitive to the amount of vegetation biomass in the scene. In only two instances did
band 5 contribute to a PC used (Appendix A) — for the 1996 and 2000 flows we used
PCs 1, 2 and 4. PCs 1 and 2 comprised reflectance from bands 1, 2, 3 and 4, while PC
4 comprised reflectance from bands 1, 3 and 5. Band 5 is sensitive to turgidity (water)
in plants. This Landsat scene was acquired in September, which is within one of the
two annual rainy seasons in the Virunga (http://www.eoearth.org/article/Virunga_-
National_Park, Democratic_Republic_of Congo#gen7); therefore, the response in
band 5 probably results from moisture-rich vegetation. As most of the reflectance in
each scene results from the abundant vegetation in the area, the flows of interest were
easily identifiable due to the stark contrast between vegetation and barren lava.

The user determines the number of classes to be generated within the classification
program. Since our input into the classification program are three PCs, and PCA is
an orthogonal transformation of the original data, the classification program creates
each class based on the distribution of the data along the entire length of the first PC
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axis. Because the first PC contains the greatest variance of data, there is an increased
separation of reflectance between, for example, bare rock/soil and vegetation along
this axis compared to the raw data (see Jensen (2007) for more detail). This
separation appears to result from the contrast between recent lava flows, which have
lower reflectance, and older lava flows and forest, which have greater reflectance due
to weathering and (re)vegetation. A qualitative assessment of this separation is
shown in figure 2. The 1986 lava flow is noticeably darker than its surroundings in
PC1 and PC4, indicating a clear spectral separation. Colour-composites of the
original Landsat image (figure 3 (@)) and the combined 3-PC image (figure 3 (b)) are
shown to illustrate that the PCA allows a more clear separation of lava flow and
surrounding vegetation. This may not always be apparent in the original imagery
and, therefore, transformations of this kind are valuable.

2.4. Unsupervised classification

The three PCA images chosen were cropped to include the area just around the flow
being mapped, which again permitted a faster, more accurate classification because
fewer pixels had to be evaluated and grouped into classes. Since a PCA was not
performed on the Hyperion scene, the original image was cropped to include the
areas just around the 2010 flow and an unsupervised classification was carried out on
the original data. Relative locations and extents of the flows were determined based
on the Smithsonian’s GVN reports (Smithsonian Institution 1971-2011) and verified
by observing two scenes bracketing the flow’s emplacement. As discussed above, an
unsupervised classification (also known as ISODATA; see Jensen (2007) for more
detail) is carried out using digital image processing software such as ERDAS
Imagine (Appendix B). The unsupervised classification program compares the

Figure 3. Colour-composite images of (a) the original Landsat data (acquired 7 August
1987) with bands 4, 3 and 2 displayed in red, green, and blue, and (b) the three PCs 1,3,4)
displayed in red, green, and blue. The 1986 Nyamuragira lava flow is more easily
distinguished, both visually and spectrally, in the PC image compared to the original image.
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reflectance of each pixel to every other pixel in the scene and groups similar
reflectances into classes.

A supervised classification was also attempted to determine if this might produce a
more accurate lava flow map. In this type of classification, training sets are acquired
for each land feature (lava flow, vegetation, water, cities) and then input into the
classification program. Compared to our unsupervised classification results, the
supervised classification method did not produce a more accurate lava flow map.
Acquisition of training sets is time-consuming and, although the results of this
method are similar to the unsupervised classification, we found the latter to be the
most efficient method.

We choose the 1986 and the 2004 Nyamuragira lava flows to demonstrate our
methodology, as the former was one of the more apparent flows to map and the
latter illustrates the limitations of the methods we used. The entire 1986 flow was
erupted onto considerably older and more weathered flows (1938-1940, 1948 and
1976-77), providing ample spectral contrast with its surroundings (figures 3 and 4
(a)). The 2004 lava flow, on the other hand, was more difficult to map using this
method. Near the summit area, spectral contrast between the 1998, 2001, 2002 and
2004 lava flows was very low (figure 4 (d)). This inhibited both visual separation of
the 2001, 2002 and 2004 flow boundaries and the ability of the unsupervised
classification to classify the separate flows. Further down the flanks, the spectral
contrast increases, allowing a clearer visual separation, as well as automated
classification.

2.5. Mapping the delineated lava flows

After the unsupervised classification, we found that some of the lava flows were
defined by one class (1971, 1984, 1986 and 1991), while the remaining flows were
defined by more than one class. The latter was due to spectral variation within the
flow, potentially caused by early revegetation of parts of the flow (if the imagery used
to map the flow was acquired over ~5 years after flow emplacement) or by intra-
flow features such as varied lava textures (c.g. Spinetti et al. 2009) resulting from
slope changes. We also found that, in some instances, the lava flow and parts of the
surroundings were included in the same class (e.g. figure 4 (a) — yellow spots
surrounding the 1986 flow, which is also displayed in yellow). Using a module in
ERDAS Imagine (“clump”), we were able to reassign the surrounding spots to a
different class number and separate these from the main flow (figure 4 (b)). At this
point, the class or classes that were identified as the flow were reassigned a value of
one and the remaining classes were assigned a value of zero (figure 4 (c)). Creating
this binary image was necessary to clearly delineate the flow from the surrounding
non-flow features. The area of each flow was determined by multiplying the pixel
count of the flow by the pixel area (table 1).

In the absence of recent field-based lava flow thickness measurements, we used a
previously reported value to determine a volume for each lava flow. Kasahara et al.
(1991) determined that an average thickness of 3 m was most appropriate based on
compiled research of past Nyamuragira eruptions and, therefore, we also adopt this
value. We considered DEM subtraction to better constrain this value, but the
vertical resolution of available DEMs is too coarse to improve upon the thickness
estimate of Kasahara et al. (1991) via DEM subtraction. The 3-m thickness of
Nyamuragira’s flows is significantly less than the average 5-16 m vertical accuracy of
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Figure 4. (a) Results of the unsupervised classification of the 7 August 1987 Landsat scene,
showing the 1986 flow highlighted in yellow. Yellow patches around the 1986 flow were falsely
classified; (b) The false pixels were easily reassigned as “non-flow” using a module in ERDAS
Imagine (clump); (¢) The final result, a binary image, is produced by reassigning the
background classes as “0” and the lava flow as “1”, which allowed a clear separation of the
1986 flow; (d) Results of an unsupervised classification of the 21 February 2005 Landsat scene.
The 2004 was more difficult to map as the overlapping flows emplaced with ~1 year of each
other had very similar spectral signatures (see black box). However, note how the flows
become easier to separate (spectral signatures are different from surroundings) down the
volcano flanks.

DEMs created from satellite imagery such as ASTER (7-15 m; Hirano et al. 2003),
SPOT (~5 m; Endreny et al. 2000) or SRTM (~ 16; Rodriguez et al. 2005) data.
IKONOS-derived digital surface models (DSMs) have a vertical accuracy of 2-5 m,
although the lower estimate was a result of flat terrain, and for vegetated surfaces,
like Nyamuragira, this value increases (Poon and Fraser 2005). DEMs derived from
light detection and ranging (LiDAR) data are more accurate (0.5 m; Liu ez al. 2007),
although LiDAR topographic data of the Virunga region are unavailable. Even if
the political situation improves, acquisition of this type of data would be very costly
due to the large spatial extent of the flows.

2.6. Special case: MSS imagery

Landsat MSS has fewer spectral bands than the TM and ETM+, requiring a
different processing scheme for the 1975 MSS image prior to the unsupervised
classification. The 1971 lava flow abutted a body of water. The available Landsat
MSS bands detected similar spectral signatures for both water and lava, rendering
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them indistinguishable through the unsupervised classification. Masking the water
from the stacked PC image remedied the effect and an unsupervised classification
was successfully performed on the 1975 image.

3. Lava flow map and derived volumes
3.1. Comparison of our lava volumes with previous studies

The map of Nyamuragira lava flows produced from the Landsat, Hyperion and
ALI image analysis is shown in figure 5. Table 3 shows lava flow volumes
calculated using the technique described above, and a comparison of our results
with previously reported lava volumes (Kasahara et al. 1991; Smets et al. 2010;
Colclough 2005). Nyamuragira eruptions from 1967 to 2011 produced between
0.005 and 0.136 km? of lava per eruption. While our data generally agree with
the volumes reported by Kasahara er al. (1991) for the eight eruptions between
1967 and 1991, there are some differences (table 3). Colclough (2005) estimated
minimum lava flow volumes for the 1998 (71 x 10° m®) and 2001 (133 x 10° m?)
Nyamuragira eruptions; our estimates agree well with their results for the 2001
flow and are within 20% of their results for the 1998 flow. In a comparison with
Smets et al. (2010), our estimates agree to within 10% of theirs, except for the
1998 flow (17% difference).

On 31 May 2003, Landsat ETM+ lost its scan line corrector (SLC) and, as a
result, stripes of missing data appear in the image. The imagery used to map the 2006
flow was affected by this condition. We were able to map the 2006 flow with the same
methods used to map the older flows, although this scene did require some
digitization in ArcGIS after the binary image from the classification was complete,
particularly in the area covered by clouds. The flow was delineated with the aid of a
Landsat ETM+ scene acquired on 28 September 2009, as well as an ASTER image
acquired on 31 August 2007. Eight out of the 19 flows (1976, 1980, 1991, 1989, 2000,
2001, 2003 and 2004) required small amounts of digitization after the classification to
remove falsely classified flow surroundings, which were not possible to separate
using the digital image processing software. Four out of these eight instances were
associated with the overlapping flows near the summit area. Due to either
atmospheric or eruption clouds obstructing parts of the 1967, 1996, 2000, 2006,
2010 and 2011 flows, these also required small amounts of digitization. The
remaining five flows (1971, 1981, 1984, 1986 and 1994) were mapped with no post-
processing.

4. Discussion
4.1. Temporal changes in lava flow spectral signature

From our PC analyses, we conclude that most of the spectral variation within the
Landsat and ALI scenes is due to vegetation and water reflectance, and that the
comparatively low reflectance of the lava flows (bare rock) provides high contrast
with the surrounding vegetation that allows the flows to be easily mapped with
unsupervised classification methods. If a new lava flow is emplaced on older but
relatively recent lava, the efficacy of the technique depends on the vegetation and
weathering rate of the flows. Ground, aerial and satellite studies of basaltic flow
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Figure 5. Map of Nyamuragira lava flows erupted from 1967 to 2011. The base map is a
Landsat ETM+ scene acquired on 21 February 2005 (band 4).

fields have shown that changes in VSWIR (0.4-2.4 um) spectral signatures result
from electronic transitions in iron in various oxidation states, as well as the
increasing extent of vegetation, as weathering progresses (Bonneville e al. 1988;
Abrams et al. 1991; Kahle er al. 1995; Spinetti et al. 2009). In order to assess how
individual flows change through time with respect to vegetation and weathering, we
must look at the reflectance of each lava flow, instead of the reflectance from the
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entire scene. To do this, we used statistics from one of the Landsat scenes, which
provided quantitative information about the weathering and vegetation processes
that occur on these flows over time. The purpose of this exercise is to determine how
quickly Nyamuragira flows vegetate and to investigate if a new flow, erupted over an
older flow, can be distinguished spectrally from the older flow.

To determine quantitatively how lava flow spectral reflectance changes over time,
we used the Landsat ETM+ scene acquired on 21 February 2005 as this scene
provides a cloud-free view of all but the 2006, 2010 and 2011 flows. We corrected this
image for atmospheric and radiometric effects using the COST model (Chavez 1996)
but performed no PCA or unsupervised classification on the image in order to
conserve the characteristics of the original data. The advantages of using a single
image are that vegetation, sun angle and atmospheric conditions are constant.
Otherwise, if two images acquired on different days are compared, parameters such
as seasonal differences in vegetation may affect the spectral signatures and not allow
a direct evaluation. We measured the reflectance spectrum of each Nyamuragira lava
flow at several locations along the flow and averaged the values. This allowed us to
compare reflectance spectra and determine how the reflectance changes with age. A
terminal lobe of the 1958 Nyamuragira lava flow was also transected to obtain an
older end member. Only the terminus of the 1958 flow was exposed in the 2005 image
and, therefore, a near-vent sample could not be acquired. In fact, several flows within
this image were overlapped by more recent flows and did not provide a full vent-to-
terminus sampling. In these situations, as many measurements as possible were taken
within the exposed area. We obtained an average band-4 reflectance of the 2010 flow
(0.05) from the Hyperion scene and a spectral profile of the 2011 flow (band 4=0.01)
from the ALI scene. These values are lower than 1967-2005 band-4 reflectances
shown in figure 6. Spectral profiles were also sampled for vegetated areas around the
flows and these reflectances were the highest of all sampled (~0.7).

Spectral variations in the visible portion of the spectrum (bands 1-3) are typically
associated with changes in the oxidation state of iron in lava flows as the flows age
(Abrams et al. 1991). We do not see any systematic change in the reflectivity of bands
1-3 with age. Instead, we found the largest variation in spectral reflectance in ETM+
band 4 and so we focus on the interpretation of this band (figure 6). Reflectance in
band 4 clearly increases with flow age, which we assume is in part due to vegetation
growth (biomass) and the spectral “‘red-edge’’; the rapid increase in the reflectance of
vegetation at near-IR wavelengths (Abrams et al. 1991; Filella and Penuelas 1994,
Seager et al. 2005). A general increase in band-4 reflectivity with lava flow age was
also found in a multi-parameter study of nine alkaline Etnean lavas (1607-2003), in
which field data and lava flow spectral signatures from a ground-based spectro-
radiometer and hyperspectral satellite data were compared (Spinetti et al. 2009).
They found that vegetation growth and weathering with time were responsible for
the increase, while tephra cover (differences in grain size) decreased a lava flow’s
reflectivity. During a field campaign in 2006, we noted that tephra was mainly found
only near-vent at the 1986 and 2006 Nyamuragira eruption vents. If this is true for
the rest of the vents, this suggests that tephra does not have a strong influence on the
spectral signatures along the length of the flow.

Using SAR, Rodriguez et al. (2001) found that Nyamuragira lava flows vegetate
completely within ~ 30 years. In lava flows under 30 years old, they found a positive
correlation between the SAR signal and soil formation (weathering)/vegetation of
Nyamuragira flows. We investigated how vegetation changes over time at
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Figure 6. (a) Spectral profiles from transects of Nyamuragira lava flows (1958-2005) from
vent to terminus (when possible) are averaged as single points for each flow year. A clear
increase in band 4 reflectance indicates revegetation of the flows as they age. The Landsat
ETM+ scene used for these transects was acquired on 21 February 2005, hence the lack of the
2006, 2010, and 2011 data points. Band-4 reflectances of the 2010 and 2011 lava flows from
Hyperion and ALI imagery, respectively, are lower than 1958-2005 values. (b) A graphical
presentation of the above points illustrates the flows that deviate from the progression.

Nyamuragira by utilizing the normalized difference vegetation index (NDVI: band 4-
band 3/band 4+band 3), which determines the amount of green vegetation in a
scene. The result is an image in which pure black represents no healthy vegetation
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Figure 7. Normalized difference vegetation index (NDVI) results for the Landsat TM scene
acquired on 7 August 1987 and the Landsat ETM+ scene acquired on 21 February 2005. The
scale is 0—1; 0 is displayed as pure black and indicates no vegetation, where 1 is displayed as
pure white and indicates complete vegetation. Revegetation of Nyamuragira lava flows results
in significant NDVI increases, where lava flows ~ 5 years apart can be distinguished spectrally
(and/or visually) from one another.

and pure white represents complete healthy vegetation cover (figure 7). We find that
the NDVI values increase with increasing lava flow age and indicate revegetation
within ~35 years of lava flow emplacement. Vegetation, and to some degree
weathering, therefore, provides the best explanation for our results. Exceptions
include the 1998 flow (on the western flank), which has a higher reflectance than
expected for its age and the 1991 flow (on the northern flank), which has a lower
reflectance than expected. The flows that deviate from the overall band-4 increase
could have weathered and/or vegetated differently than surrounding flows. Future
ground-based investigations would be helpful to resolve these differences. Based on
the spectral profiles and NDVI results, it appears that most flows will start to
revegetate and weather sufficiently within ~ 5 years in order for band-4 reflectances
and NDVI values to differ markedly from a fresh flow. This contrast greatly
facilitates the mapping of lava flows emplaced through heavily vegetated areas
(forest) and on top of previously erupted flows (older flows which are in the process
of revegetating) in the Virunga region.

4.2. Lava flow volume errors

We identify three sources of potential error within our volume estimates using
Landsat, Hyperion, and ALI data: (1) inaccurate lava flow boundaries due to the
flow edge occupying only part of a Landsat/Hyperion/ALI pixel; (2) erroneous
inclusion of surrounding substrate as lava flow and (3) the average lava flow
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thickness used. Even in the most extreme case (an off-set of one pixel for the entire
perimeter of the largest lava flow, 2001), the perimeter of the flow only accounts for
~16% of the total flow area. In reality, these errors would be negligible as some
perimeter pixels will be within and others outside of the chosen boundary. The
second error was greatest when overlapping flows near the summit were difficult to
delineate (e.g. it would be a ~20% difference if we assumed that the 2004 flow in
figure 4 (d) extended to the summit, compared to its actual extent, seen in figure 5).
However, the largest source of error, as Smets et al. (2010) also points out, was the
flow thickness. Calculating volumes with a 1 and 5 m thickness (3 +2 m) results in a
200-400% difference in the largest flow volume (2001) compared to the volume
calculated with the average 3 m thickness. Since Smets et al. (2010) and Colclough
(2005) also use the 3 m average lava thickness suggested by Kasahara et al. (1991),
our volume estimate comparisons are actually comparisons of lava flow areas. The
good agreement between our data and these prior estimates suggest that we have
similarly detected flow boundaries.

5. Conclusions

Mapping Nyamuragira’s lava flows using PCA and automated unsupervised
classification techniques has proven successful for most eruptions of the volcano
since 1967. Unsupervised classification resulted in well-separated classes, which
allowed easy discrimination of lava flows from surrounding features. The spectral
contrast between flows that permits accurate mapping reflects (re)vegetation and
weathering of the flows with time; revegetation progresses enough within ~5 years
that the reflectance and NDVI values are significantly different than those of younger
flows.

Overlapping lava flows emplaced within small time spans (e.g. the 2000 and 2001
flows to the SE or the 1998, 2002 and 2004 flows to the NW) required post-
processing to delineate boundaries nearest the summit. This was accomplished
through examination of images acquired prior to and after the emplacement of the
flow in question to discern some of the overlapping boundaries. Experimenting with
band combinations during the process allowed overlapping flows to be more easily
separated. During this post-processing, more difficulty occurred when delineating
flows closer to the summit crater, possibly due to the larger extent of overlapping
flows, slope effects (e.g. thinner flows being more easily weathered) or satellite
geometry.

We found that the use of automated classification methods with VSWIR satellite
imagery for mapping lava flows is useful and cost-effective in regions such as
Virunga, particularly for lava flows erupted through vegetation or emplaced on top
of older, revegetating lava flows (>35 years). In these situations, where cloud-free
satellite imagery is available, this method is faster than manually digitising flow
perimeter, especially for flows with intricate flow paths around elevated areas called
kipukas. Even in situations where some digitization is needed after the automated
classification routine due to cloud cover or spectral ambiguity, the automated
methods can serve as an aid to mapping by performing the initial work more quickly.
In the case of digitization alone (no automated methods), the time required to map a
flow varies greatly and depends on the size of the flow, the dataset being used (e.g.
resolution), and the level of flow complexity the user wants to display. With
automated methods, on the other hand, the size of the flow does not significantly
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increase the processing time. Furthermore, the automated techniques and PCA
provide insights into the underlying subtle spectral differences between the lava
flows, whereas manual techniques do not.

In situations where overlapping flows are present, the automated method could be
used with radar, which has proven useful for separating the flows based on
roughness differences. In addition, the ability of radar to penetrate clouds is
advantageous in this equatorial area due to the cloud cover that often obscures
optical satellite imagery. However, VSWIR imagery is still often needed in
conjunction with radar to delineate boundaries (e.g. Colclough 2005; Smets et al.
2010). Our derived lava flow volumes for Nyamuragira eruptions from 1967 to 2010
are similar to those previously reported lava volumes (Kasahara et al. 1991,
Colclough 2005; Smets et al. 2010). At the time of writing, this is the first estimated
lava volume for the 2011 flow. Although lava flow overlap occurred more in flows
emplaced between 1994 and 2010 due to a concentration of activity in a NW-SE rift
zone since 1996, the percentage of overlap was small compared to the entire area of
the flow.
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Appendix A

Factor loadings for Landsat images used to map Nyamuragira lava flows (1967
2004). Those factor loadings displaying <6 PCs indicates either low spectral
resolution scenes (e.g. 1974) or corrupted bands (e.g. 2003). The dark black outlines
indicate the PCs chosen for unsupervised classification and the dark shaded cells
represent the bands from the original imagery that contributed most to each PC. The
PC combination used to map the individual flows are listed next to the flow year;
those lightly shaded cells represent a deviation from PCs 1-3.

Imagery used- 4 December 1974
Flow mapped: 1967: 1,2,3 1971: 1,2,3
PCs used
PC1 PC2 PC3 PC4
B1 0.593 889 10.625 ~2.300
B2 0.257 0.7 ~ 0.059 0.728
B3 0.078 0.008 —0.092 —0.011
B4 0.054 0.026 0.047 0.005
Imagery used- 7 August 1987
Flow mapped: 1980: 1,2,3 1981: 2,3,4 1984: 1,24 1986: 1,2,3
PCs used
PC1 PC2 PC3 PC4 PC5 PCé
1 ~1.163 ~0.326
1.009 2.522
0.630 —0.648
—0.018 —0.006
0.023 0.002
—0.054 0.006
Imagery used- 17 January 1995
Flow mapped: 1989a: 1,2,3 1994: 1,23
PCs used
PC4 PC5 PCo6
B1 1.495 0.430 —0.185
B2 —0.501 —0.065 —-0.714
B3 —0.090 —0.119 0.181
B4 0.008 0.039 0.029
B5 0.018 —0.042 —0.021
B7 —0.028 0.067 0.016
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Imagery used- 6 December 1999

Flow mapped: 1989b,c: 1,2,3 1991: 1,2,3 1996a: 1,2,3
PCs used

PC1 PC2 PC3 PC4 PC5 PCé6
B1 0.576 V —0.811 2732 0.395
B2 0.125 - 0.92¢ —0.342 —1.382 1.757
B3 0.109 0.225 0.046 —0.161 —0.351
B4 —0.057 —0.001 0.017 0.003 —0.004
B5 —0.033 0.050 —0.045 0.000 —0.007
B7 0.008 0.049 0.076 0.016 0.020
Imagery used- 3 September 2000
Flow mapped: 1996b: 1,2,4 2000b: 1,2,4
PCs used

PC1 PC2 PC3 PC5 PCé6
B1 : ~0.492 1.675 0.606
B2 —0.130 —0.082 —0.416
B3 —0.008 —0.173 0.128
B4 —0.117 —0.004 0.032
B5 0.028 | 0.010 —0.007
B7 0.032 —0.039 0.003 0.002
Imagery used- 11 December 2001
Flow mapped: 2000a: 1,2,3 2001a,b: 1,2,5
PCs used

PC1 PC2 PC4 PC5 PCé
Bl 0621 1522 —3.824 —2.165
B2 0.004 0.7 —0.429 2.808
B3 10.102 0.243 —0.235
B4 —0.073 0.020 —0.006
B5 —0.058 —0.038 —0.009
B7 —0.010 0.109 0.017
Imagery used- 31 January 2003
Flow mapped: PCs 2002a: 1,2,3 1998: 1,2,3
used

PC1 PC2 PC3

Bl . age 23¢
B2 . 0730
B3 L =0.007
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Imagery used- 21 February 2005
Flow mapped: 2002b: 1,2,3 2004: 1,2,3
PCs used

PC4 PC5 PCé6

B1 3.886 2.246 1.551
B2 0.047 —0.344 —2.992
B3 —0.248 —0.399 0.297
B4 —0.011 0.008 0.006
B5 0.040 —0.043 —0.003
B7 —0.066 0.078 0.003
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Appendix B

This flowchart describes, step-by-step, the processing routine we used to map
Nyamuragira lava flows. We used ERDAS Imagine image processing software and
ESRI ArcGIS software in our study, but these instructions can be translated to other
image processing and mapping programs.

Import satellite data: Manage Data
>Import Data>(choose import file
type and file)

Combine bands of interest (e.g., Landsat 1-
5, 7): Raster>Spectral>Layer Stack

y

Run Principal Components on stacked
satellite image: Raster>Spectral>Principal
Components Analysis

[ rcif rcz g pcaf rca f pcs 4 rce /

hoose 3 PCs that bes!
highlight the feature of
interest and combine
them into one image:
aster>Spectral>Laye

Crop combined PC image around the lava
flow of interest: Raster>Subset &
Chip>Create Subset Image

¥

Run an Unsupervised Classification on the cropped PC
image: Raster>Unsupervised>Unsupervised Classification

y

Using the Recode feature, reassign the lava flow as one
class (or several) and everything else as another class (or
several): Raster>Thematic>Recode

v

Run the Clump feature using nearest neighbor
- this will combine the closest pixels of like class:
Raster>Thematic>Clump

y

To create the final image, reassign the lava flow as 1
and everything else as 0, using the Recode feature:
Raster>Thematic>Recode

No digitizing needed? /

\ Digitizing needed?

Right click on file name and “Display Attribute Table™-
Multiply pixel count of the lava flow class by the pixel area
(e.g., Landsat = 900 m?). Multiply this result with flow
thickness for volume. Create shapefile in ArcGIS with
instructions (first sentence only) to the right.

Open .img file in ArcGIS and covert to shapefile: Arc
Toolbox>Conversion Tools>To Shapefile. Edit this shapefile:
Editor>Start Editing (choose the file you want to edit and
double click on outline to begin editing). When editing is
complete, convert file back to raster for area calculation:

AN

Toolbox>Conversion Tools>To Raster
/

Insert shapefile(s) onto a background (e.g., cloud-free
satellite image) in ArcGIS.
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